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PP rr oo cc ee ss ss ii nn gg   WW oo rr dd ss ::     AA uu tt oo mm aa tt ii cc   

TT yy pp ii nn gg !!   

AutoCorrect 

Using AutoCorrect features in the Office Suite, particularly Word can be one of the most 

productive tools in the application and it can be one of the most frustrating tools in the 

application.  Although clients learn this feature and trainers/consultants try to 

emphasize this important feature, it still goes underutilized.  Knowing that AutoCorrect 

is where the Office suite changes the word abbout to about and that AutoCorrect is 

where you turn off some annoying self correcting 

items, such as capitalizing the first letter of a sentence.  

I have a client that doesn’t use capital letters in her 

name, I have a customer whose name begins with two 

capital letters, and I may have a customer named Abbout – AutoCorrect could drive me 

crazier than I am, if I didn’t know how to change or stop these 

automatically altered items.  You can always activate the AutoCorrect 

features through the Microsoft Office Button, clicking the Word 

Options button at the bottom of the pane, and from the Word 

Options screen and the Proofing item, and finally choosing 

AutoCorrect Options, as displayed at right.  This feature 

spans the Office Suite in one form or another.  When an 

AutoCorrect feature or item is used a small, blue rectangle 

will appear under the word or item changed or used by 

AutoCorrect, Clicking the little, blue bar will activate the 

AutoCorrect Options icon (it has a lightening bolt).  One of 

the most annoying items for the Legal Profession is 

AutoCorrect’s using the (c) to change to the copyright 

symbol ©.  I instruct legal personnel to change the 

AutoCorrect feature to use dashes or another symbol to 

surround the c.  Displayed at right is the  AutoCorrect 

Options.  This is a great utility to be familiar with and to 

use often.  Displayed at right is the full AutoCorrect 
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Options menu that activates  by clicking the Control AutoCorrect Options on the 

AutoCorrect Options icon or from the Word Options screen, the Proofing section and 

selecting AutoCorrect Options.  

 Notice this happy face – AutoCorrect can enter this for you by typing a colon : and a 

closing parenthesis ) or  the frowny face (this is what I use for the Important Gotcha’s 

in this book) is the colon : and opening parenthesis (.  Try it, you’ll like it.  

Here are some of the important reasons to use AutoCorrect: 

 Automatically capitalize acronyms, 

 Correctly spell words that you typically misspell, 

 Automatically types your name, address, etc with a “code” or keyboard 

shortcut, 

 Automatically enters  entire paragraphs, letters, and disclaimers with a “code” 

or keyboard shortcut, 

 Insert your favorite symbols and characters with a “code” or keyboard 

shortcut. 

 An Important Gotcha!   If you use the “Stop Automatically Correcting” 

item on the AutoCorrect Options Icon Shortcut menu, it will DELETE 

YOUR AutoCorrect ENTRY.  Word will not only stop automatically 

correcting for this incident of AutoCorrect but also for all future items; you 

will have to add the AutoCorrect Entry, again for it to be available.  The 

Change back to option will facilitate most of your AutoCorrect nuisances.  

Anytime AutoCorrect is used by Word a blue bar underlines the item waiting 

for you to click it to get the AutoCorrect icon.      

At right I have displayed another popular item in AutoCorrect and that is the ability to 

continue or restart your numbering.  I have clicked my number icon 

on selected text and the AutoCorrect icon appears at my new 

number list.  When I click the AutoCorrect icon, I am provided with 

the shortcut menu to Continue numbering (rather than Restart my 

numbering from 1).  
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Let’s learn the important features of AutoCorrect 

 

1. Open a blank document type your name and then (c) and the 

Copyright symbol should appear or type abbout and Word 

should correct it to about. 

2. Return to the item, and click the little blue bar 

for the AutoCorrect Options 

3. Change it back to the original input of (c) or 

“abbout” – this is pictured at right.  

4. Return back and click the Control AutoCorrect 

Options to activate the menu below.  Notice the options that 

you can have AutoCorrect perform for you, 

such as Capitalize first letter of sentences, 

if you uncheck this it will not automatically 

correct for you.  Notice the area where you 

can edit or input new AutoCorrect items.  

5. For fun and productivity, type your initials 

in the Replace box  If your initials spell a 

word, type your first two initials and then 

the number 1 like this, ca1.  Then type 

your full name in the With  Box, My entry is 

displayed at right. 

6. Click the Add button. 

7. Click OK.   

8. Back in your document, Type your initials, press your space 

bar or press enter.  Watch as Word types your name.  Great! 

Let’s have AutoCorrect type your name, address, and phone number for you. 

1. In your practice document, type your name, address, and phone 

number as my information is illustrated below. 

Greg Creech 

P. O. Box 1431 

Pine Lake, GA  30072 
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404-299-1706 

2. Format your text as you wish. 

3. Select all of your text including the paragraph marks. 

4. Click the Microsoft Office Button,  

5. Click the Word Options button at the bottom of the screen, 

6. Select the Proofing item in the Word Options screen and click the 

AutoCorrect Options button, 

7. This is way too many steps for me to activate AutoCorrect; I add 

this to my Quick Access Toolbar.   

8. Notice the With box has your text and the Formatted Text radio 

button should be checked for you, if not make sure the 

Formatted Text box is selected. 

9. In the Replace box type your own code; I used ad1. 

10. Click Add. 

11. Click Close 

12. In your document, type your code you assigned in Step 8. 

There is your formatted Name, Address, and Phone number. 

To get practice and reinforce your skills perform the following AutoCorrect exercises: 

 Select any paragraph in a document and assign an AutoCorrect shortcut to 

have Word type an entire paragraph for you.  My clients use AutoCorrect to 

have Word enter disclaimers, such as the medical profession using HIPPA 

disclaimers. 

 Also, type your favorite acronym, like ATM, in lowercase in the With box like 

atm and in the Replace box type ATM.   

 Add your frequent misspelled words to have Word spell them correctly.  I 

misspell Atlanta all the time so I have several entries to correct Atlanta when I 

type Atalnta or Atanlta, etc. 
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 You can add your own words, especially for professional and technical career 

fields, such as legal and medical terms. 

 As I wrote earlier, be careful about the shortcut words/letters you use for 

AutoCorrect.  I taught this in a Word class several years ago and a woman named 

Catherine Anne Thompson entered an AutoCorrect feature using her initials “cat” to 

type her name. This worked great, UNTIL another woman took my Word class several 

months later and opened a book she was writing about cats.  When she typed cat, guess 

what Word did? Changed her word “cat” to Catherine Anne Thompson.  My new client 

screamed:  “Creech! This woman named Catherine Anne Thompson has possessed my 

computer!” I knew exactly what had happened and promptly deleted this AutoCorrect 

entry.  

AutoCorrect “Symbol”isms 

 The copyright © AutoCorrect  option we entered earlier is a symbol.  AutoCorrect has 

other symbols for trademark ™ (type (tm) for Word to enter this for you), registered 

trademark ®, (type (r) for this).  Also, I showed you the smiley 

and frowny faces and the keystrokes – these are a type of 

symbol, too.  Symbols are a type of font and include other fonts 

like Webdings, Wingdings (displayed at right), and other special 

fonts.  While these may not look like fonts, they are.  You may 

format them, as with any font, such as size, color, and other 

formatting.  Let’s create our own AutoCorrect symbols, as I 

have accomplished with this book for the notes  and the 

jalapeño pepper .  Let’s accomplish this together following 

the steps in the next section. 

Here’s some important notes on Symbols and AutoCorrect 

 The Symbol dialogue box activates through using the Insert Tab on the  Ribbon 

and selecting Symbol and clicking More symbols as displayed at right.  

 In Word, you may activate this menu through the Home Tab item and then 

Bullets and Define New Bullets as we accomplished earlier. 
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 Using symbols with AutoCorrect is very popular for engineers, accountants, 

linguists etc to add items such as degree symbols, foreign currencies, and other 

language’s special characters. 

Let’s use the symbol dialogue box and create an AutoCorrect entry for it.  While you 

may insert a symbol and use AutoCorrect in Excel and PowerPoint, Word allows you to 

insert a symbol AND go to AutoCorrect or assign a keystroke for your symbol quicker 

and easier than other applications. 
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1. In a blank document or use your previous AutoCorrect practice 

document, click the Insert Tab and the Symbol button.  Notice 

the predefined symbols in your gallery that you may use.  

2. Click More Symbols. . . 

3. The Symbol Dialogue box appears. 

4. Choose the font you wish to work with 

(Webdings and Wingdings are popular 

symbol fonts, as I related earleir). 

5. Next select a symbol by clicking it.  

6. Click the AutoCorrect button at the bottom of 

your pane. 

7. The AutoCorrect dialogue box opens with 

your symbol in the With section. 

8. Next type your keyboard strokes for this 

symbol in the Replace box – I have typed 

(w) for my Microsoft Windows symbol. 

9. Click Add 

10. Next click OK. 

11. You return to the symbol dialogue box.  Next 

we’ll give this another keyboard shortcut.   

CARE should be used in assigning keyboard 

shortcuts because many keyboard shortcuts 

are already assigned in the Office 

applications – you don’t want to overwrite 

important shortcuts like CTRL + C which is 

the shortcut for copy.  

12. At the symbol dialogue box click the Shortcut key button. 
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13. The Customize Keyboard dialogue box 

appears.  In the Press New Shortcut key box 

- Press your combination of keys until you 

find one that is not used or assigned – I have 

use the ALT + SHIFT + W to insert my 

Microsoft Window symbol.  

14. Once finished Click Assign. 

15. Then Click Close. 

16. At your Symbol screen, Click Cancel. 

17. Now try out your new AutoCorrect entry and 

the keyboard shortcut for your symbol.   

 

 The trick to all of this is to remember your keyboard strokes and that you have 

accomplished this and can reuse the symbol forever.  

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 

 

________________________________________________________________________ 
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AutoCorrect Letter 

This exercise will demonstrate how you can have Word type an entire letter for you.  

The limit on Non-formatted AutoCorrect entries is 255; I’m unsure of the limit in the 

formatted AutoCorrect entry, but it is a lot as you will see. 

1. Open the file Form Letter.doc, 

2. Press the CTRL + A keys to select all of the text 

or triple click in your Selection Bar area to select 

all of the text. 

3. Navigate to your AutoCorrect Options through 

the Microsoft Office button and Word Options. 

4. Notice Word has your letter in the with box. 

5. In the Replace: box enter your keystrokes, I 

have entered ltr1.  

6. Click Add and Click Ok. 

7. Open a blank document and type your keystrokes, such as ltr1. 

8. Wow! That’s what I call Word Processing. 
 Word did not convert the Header nor Footer, which we will learn soon.  


